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Introduction 
Economacs is an easy-to use bookkeeping and invoicing software for Mac OS X. The program, and 
this manual, assumes understanding of the basic concepts of double-entry bookkeeping (such as 
entries and accounts). If you don’t understand these concepts, we recommend that you first 
familiarise yourself with them by using some of the numerous resources in the field. 

Installation & start-up 
If you purchased Economacs from the Mac App Store, no further installation is necessary. Otherwise, 
drag the application (“Economacs”) from your Downloads folder to your Applications folder.  
Double-click to start the program. The file selector will be displayed, allowing you to choose to start a 
new document, view video tutorials (subject to availability), or visit our web site. Once you’ve created 
your own documents you will also be able to select from the latest Economacs documents. 

Registration 
For Mac App Store customers, no registration is necessary or even possible. If you purchased 
Economacs directly from us, you will have received an email with a serial number. You need to use 
this serial number to unlock the application. You can do this by selecting Economacs→Register... 
from the menu. Enter your serial number and other details and click ‘Register’. Note that this requires 
an active Internet connection. You can re-use the same serial number to install the software on all 
computers where you want to use the software. 
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The main window 
The main window contains: 
1. A toolbar with shortcuts to frequently used actions. 
2. A sidebar in which you select what is shown in the main view. 
3. A main view whose contents depend on the selection in the sidebar (2). 
4. Most views also contain a help button in the lower right corner. This provides context sensitive 

help for the current view. 

Filing entries 
Chart of accounts 
Before you can start filing entries, you need a chart of accounts. To see the chart of accounts, select 
‘Accounts’ from the sidebar. The main view changes to show a table which you can fill with your chart 
of accounts. If you selected one of the bundled charts to start the a new document, this table will 
already contain many accounts, to which you can add your own if necessary. 
To add a new account, click the ‘+’ button near the bottom. To remove an account, select the 
account and click the ‘-’. Please note that you cannot remove an account once it has been used in an 
entry. 
For each account, you need to specify an account number, a description, and the type (Asset, 
Liability, Equity, Revenue or Expense). You may also specify a VAT code and a tax code; these fields 
are used for generating ‘special’ reports and are optional. For income and expense accounts, you can 
also specify a VAT level (normal or reduced). This VAT level is used when helping you create entries 
(see below). 
The VAT code is used to construct a VAT report; accounts are grouped according to the VAT code 
and all activity for each VAT code for a specific reporting period is shown on the report. For most 
cases the VAT code will be blank. Unless there is a specialized VAT report available in Economacs for 
your country, you can enter anything as a VAT code; the generic VAT report will use whatever you 
enter. 
The format for account numbers varies across Europe. You can change how account numbers are 
displayed and sorted from the Preferences menu. 

VAT levels 
If you want to take advantage of the quicker means of filing entries (see below), you need to connect 
VAT accounts to income and expense accounts. This is done using VAT levels. There are three VAT 
levels: the normal VAT level and two different reduced VAT levels. For each income and expense 
account you select one of these levels, or 0% (VAT free). 
Under the ‘VAT’ settings item in the sidebar (note, not the ‘VAT’ item under ‘Reports’) you can select 
accounts to use for each of these VAT levels. 

N.B. You can only select accounts that are of the ‘Debt / equity’ type. The 
accounts must also have a VAT code (see above). 

The new entry 
Once you have a chart of accounts, you can start building an entry. Select ‘New’ from the ‘Entry’ 
group in the sidebar (or click ‘New entry’ in the toolbar). Here you have three methods to create a new 
entry, ”Expense”, ”Income” and ”Other / manual”. Switch between these methods using the tab 
buttons at the top of the view. 

	 "                                                                                                                                                                           4

☞



Aderstedt Software AB

In the lower part of the view you have controls common to all three methods: the entry name (a brief 
description for the journal and ledger), some optional comments, a date and an optional image (e.g. a 
scanned receipt). When choosing a date for the entry, keep in mind that the program enforces a strict 
date order, which can be disabled by clicking the lock icon next to the calendar. You should also be 
aware of the fact that Economacs stores any added receipt in your accounting file. If you add many  
large receipts your file will become very large. Receipts will be capped at approximately 100 kB.  
If you are registered for VAT, both the ‘expense’ and ‘income’ methods require that you’ve set up the 
appropriate accounts in VAT settings (see above). 
Expenses and incomes 
Using the these method Economacs can guide you to creating an entry of the corresponding type. 
Enter the requested information. When you are done, the ”File” button in the lower right corner will be 
enabled and you can file the entry. You can also switch over to the manual mode to see the details of 
the created entry.  
Manual mode entries 
In manual mode you enter each row of the entry manually. Add or remove rows using the 
‘+’ (keyboard shortcut ⌥⌘N) and ‘-’ buttons. Each row requires an account and a non-zero value for 
debit or credit. If you’ve specified any tags you can also assign tags to individual rows. Note that you 
should only assign tags to income or expense accounts. 
If you wish to see the chart of accounts, you can select View→Show chart from the menu to open it 
in a drawer. 
The entry can be filed using the ‘File’ button (⌘R) once you have entered two or more rows that are 
balanced (i.e. the sum of debit values matches the sum of credit values). You can balance the entry 
automatically by using the ‘Balance’ (⌘B) button, which makes the entry balanced by changing the 
debit/credit values of the currently selected row. 
File as pending 
If you want to add the entry to the pending queue to be filed in chronological order, you can press ⌥ 
when clicking ’File’. The entry will be placed in the pending queue. 
Accrual of revenue and expenses 
You can automatically accrue revenue and expenses by holding ⇧ when clicking ’File. A small 
popover UI will open, where you can select the months over which to accrue the entry, and the 
accrual account to use. Months that have already passed will be added to the initial entries. For 
months that haven’t passed, accrual entries will be added to the pending queue. 

Changing a filed entry 
If you immediately realize that you’ve made a mistake when filing an entry, you can use the undo 
feature (by accessing the menu Edit→Undo or typing ⌘Z). You can undo repeatedly as far back as 
the last save. 
If you wish to change an entry that was filed a while ago, select its fiscal year from the sidebar, then 
select the entry from the list in the main view, and click the ‘Edit’ button at the bottom. A list of the 
rows in the entry will be displayed in a sheet panel on top of the main window. This list is similar to the 
list of rows for the new entry, with a few differences: 
1. you cannot delete a row completely. Removing a row marks it red; it will no longer affect balances 

etc., but it will appear as crossed-over in the ledger and journal. 
2. new rows added are in bold-face. 
Altered rows will be displayed in the journal and ledger with a note showing the date when the change 
was made and by whom (the full user name of the currently logged in user).  
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The journal 
Filed entries are sorted into fiscal years. For each fiscal year there is a sequence of entry numbers; a 
newly filed entry is given the next number in this sequence. You can see both which fiscal year and 
what number the entry received after filing it by observing the animation that occurs directly after you 
click the ‘File in journal’ button. The number of the next entry is also displayed in the caption on the 
‘File’ button. Note that since there may be entries enqueued under ‘Upcoming’, the next entry 
number will depend on what date you choose in the calendar. 
For each fiscal year you can see the journal of entries, by selecting the fiscal year in the sidebar from 
the ‘Entries’ group. There is also a list of pending entries. You can delete entries from this list by 
selecting them and choosing Edit → Delete from the menu. 

Tags 
Economacs supports assigning tags to individual rows in entries. You can define tags by selecting 
‘Tags’ in the sidebar, which causes the main view to switch to a table with the currently defined tags. 
Here you add or remove tags using the ‘+’ and ‘-’ buttons. For each tag you specify a number and a 
name.  
Once you have defined at least one tag, an additional column appears in the table of rows in the new 
entry. This column lets you specify the number of a tag that you wish to assign to that row. 

Fiscal years 
You can only file an entry with a given date if that date is within a fiscal year. When you start a new 
document Economacs creates a fiscal year corresponding to the current calendar year. If you have a 
different fiscal year, or wish to start bookkeeping on an earlier fiscal year, you will need to make 
changes to the list of fiscal years. Select ‘Fiscal years’ in the sidebar to show the list of fiscal years. 
You can add or remove fiscal years using the ‘+’ and ‘-’ buttons. Once entries have been filed in a 
fiscal year, that fiscal year can no longer be removed. For each fiscal year, you supply an arbitrary 
name, a starting date and an ending date. The fiscal year includes the ending date. That means for 
the calendar year as a fiscal year, the year should end on the 31st of December.  

N.B. You can send invoices on a date that isn’t within any defined fiscal year, but 
you won’t be able to select it after sending it since there is no appropriate folder in 
the sidebar for it. Create a fiscal year encompassing the invoice date to see it.  

Starting balances 
If a fiscal year does not represent the first year of operation for the company, you most likely have 
starting balances for accounts representing assets and liabilities. To the lower right in the fiscal year 
view there is a list of starting balances for the currently selected fiscal year. You can add or remove 
starting balances using the ‘+’ and ‘-’ buttons. For each row, you must specify the account number 
and the balance. 
You can calculate the starting balances of a year based on the previous year, if it exists, using the 
button ‘Calculate from previous year’. 
Keep in mind that the starting balance for many accounts representing liabilities (debts and equity) will 
be negative and have to be entered as such in the starting balances. The sum of all balances must be 
zero. If it is not, the difference will be shown in red below the list of balances. 

Supplier invoices 
Most invoice features in Economacs relate to invoices you send to your customers, but the 
application also supports supplier invoices. Under the ‘Entries’ heading in the sidebar you will find 

	 "                                                                                                                                                                           6

☞



Aderstedt Software AB

‘Supplier invoices’. In this list you find all supplier invoices you have created. Here you can quickly see 
overdue supplier invoices, apply status changes to active supplier invoices and create new ones. 

Adding a supplier invoice 
To add a supplier invoice, click on the ’+’ on the bottom left. The top part of the view displays 
information pertaining to the supplier invoice: invoice number, a supplier, a comment and a list of 
amounts. You can either select a supplier from the contacts database, or type in a company name to 
add a new supplier. If you want to select a supplier from the Contacts database in Mac OS X you 
must first create the supplier under Contacts in the sidebar. 
For each amount you enter an account. The list of accounts to choose from includes all debt 
accounts for which the VAT code isn’t empty, and all expense accounts. If the invoice includes VAT 
you need to specify it as a separate item. If you specify an account that has a VAT level configured, a 
VAT row will be added automatically when you use tab to move to the next row. Ensure that the 
amount on this row matches the VAT amount on the invoice.; it is not calculated automatically.  
You don’t need to create a row for accounts receivable. 

Registering the supplier invoice 
Click ‘Register’ to register the supplier invoice as received or paid. An entry will automatically be 
created if automatic book-keeping is turned on. The entry will appear among the ‘Pending’ entries.  
The process of registering the supplier invoice differs depending on your chosen invoice filing method: 
- If you only file one entry (when the invoice is paid) you need to specify the payment date, and from 

which account the payment was drawn. 
- If you file two entries (one when the invoice is sent or received, and one when it is paid), you need to 

specify an invoice date or due date, and the credit period in days. Note that you need to configure 
the ”Accounts receivable” account under Settings / Invoicing. 

If the invoice is in a foreign currency Economacs will also require an exchange rate. Use the ’Lookup’ 
button to attempt to fetch the current exchange rate from the European Central Bank.  

Registering a supplier invoice as paid 
You can mark invoices that aren’t paid as paid. Select the invoice and press ’Mark as paid’ below the 
table. Choose a date, an account and the amount. The amount must match the invoice amount 
exactly if the invoice is in the local currency, unless you check ’Partial payment’. For foreign currency 
invoices, the difference between the amount in accounts receivable and the actual paid about will be 
filed in the accounts for exchange rate gains / losses specified under Settings / Invoicing. 

Invoicing 
An invoice in Economacs is constructed from a number of invoice lines, with each invoice line 
optionally referring to a specific product. An invoice is either not sent, in which case you may add or 
remove invoice lines and change other details, or sent, in which case you may not change anything 
except its status. 

Products 
When selecting ‘Products’ from the sidebar, the main view switches to a list of products. Here you 
can add or remove products using the ‘+’ and ‘-’ buttons. For each product you enter a number 
(which need not actually be a number; it can contain letters, hyphens, et.c.), a name, a default price, 
and whether it is a good or a service. You must also specify the sales account used for the entry 
created by the automatic bookkeeping. This determines the VAT account to use and the VAT rate, 
through the VAT level of the sales account.  
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To send invoices with invoice items (”lines”) without a specific product you need to specify a default 
product. The default product is used to provide a template for these invoice lines when creating 
entries. Select which product is to be the default one from the popup at the bottom of the window. 
If you wish to use Economacs to only send invoices, you must still have a few accounts defined, in 
order to define sales accounts for your products. This is the only way to set the VAT rate on each 
product. 

Unsent invoices 
Unlike the new entry in the journal (of which there is only one), you can have several simultaneous 
invoices that await sending. By selecting ‘Unsent’ from the ‘Invoice’ group in the sidebar you can see 
the currently selected unsent invoice. If there is no such invoice, all you see is a button for creating a 
new invoice. 
Once you’ve created an invoice you fill out the invoice fields. You can choose between existing 
customers in the menu or type in a new company name to create a new customer. If you want to 
choose the customer’s address from the Contacts database in Mac OS X you’ll need to create the 
customer under Settings / Contacts first. 
You can add or remove invoice lines by typing in the invoice line columns. For each line you must at 
the very least specify a price. If you select a product from the product list its price will be copied to the 
invoice line price. Changing the price in the invoice line will not affect the product registry and vice 
versa.  

VAT number checking 
Economacs can check the VAT # entered in the ‘Customer VRC’ field with the EU commission central 
database for VAT numbers if you have a valid Internet connection. You can do this under Settings / 
Contacts, or by clicking ’Edit’ next to the customer to see detailed information. Click the ‘Check’ 
button. When the check completes you will be notified in a popup sheet of the results. 
If the VAT # checks out, or if the invoice is VAT free for some other reason, you can disable VAT for the 
invoice using the VAT checkbox. 

N.B. The VAT number checking relies on different servers for different countries (all relayed 
through the servers of the European Commission), operated by the respective tax authorities. 
Some of these servers are often down. 

Discounts 
Optionally you can specify a discount for each invoice line. The discount can be stated in relative 
terms (e.g. 10%) or in absolute terms (e.g. £10); for the latter you must use the same currency as the 
invoice is in. You can also specify a total invoice discount in the same manner as discounts for 
specific invoice line. A total invoice discount can only be expressed in relative terms. 
Discounts are not handled separately when filing entries for the invoices. They are simply treated as a 
reduction in sales. 

Templates and languages 
You select a template to use from the available templates in the Templates popup menu. You can add 
or remove templates in ‘Invoicing’ under the ‘Settings’ heading in the sidebar. 
You can choose an invoice language using the Language popup menu. The list of languages depends 
on the selected template. Note that this setting only affects the predefined text on each invoice. It 
does not translate your invoice item descriptions, for example. 
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To get your logo on the invoice there’s no need to make a custom template. Just add the logo under 
Settings / General in the sidebar, and it will appear on all invoices. We recommend using PDF format 
for the logo for higher print quality and reduced file size of printed invoices. 

Currency 
If you select a different currency for an unsent invoice, all prices in the invoice item list should be 
changed to reflect the new currency. This change does not take exchange rates into account; you will 
need to set the prices manually.  
When you send an invoice in a different currency, you will be asked to provide an approximate 
exchange rate used to calculate the amount for the accounts receivable. Economacs attempts to load 
the exchange rate from the European Central Bank, if an Internet connection is available. 
Once the invoice is paid, and you receive the amount in your local currency, you must specify how 
much you received. The difference between how much you received and the estimate made upon 
sending the invoice will end up in the currency gains / currency losses accounts that you’ve specified 
under Settings / Invoices. 

Tag 
If you’ve defined tags (see below) you can assign a tag to the invoice using the Tag popup menu. 

Rounding 
In many currencies it is customary to round off the invoice amount to the nearest integer. Check the 
‘Rounding’ checkbox to enable rounding. Rounding amounts are filed under the rounding account 
specified under ‘Invoicing settings’. 

Envelopes 
By clicking the envelope icon under the table of invoices you can print a C5-size (167 mm x 229 mm) 
envelope with the recipient’s address. This requires a printer capable of printing this media size. This 
function can also be accessed after the invoice has been sent, in the invoice list. 

Sending the invoice 
When you have at least one invoice line on the invoice, the ‘Send’ button at the bottom is enabled. 
After sending the invoice can now be found in the invoice list for the fiscal year containing that date 
(the ensuing animation indicates the fiscal year in question). If you haven’t created a fiscal year for the 
invoice date you will need to do so before you can see the invoice. 
Note that the invoice isn’t actually sent to the recipient when you click ‘Send’. To do so, select the 
invoice in the invoice list and print it (either as a PDF to send it electronically, or on paper). 

The invoice lists 
Under the ‘Invoice’ group in the sidebar is an item for each fiscal year, containing the sent invoices for 
that fiscal year. The invoice list is shown in a table displaying the invoice number, invoice date, the 
recipient, the status and the invoice amount. 
There are a number of actions available for each invoice. These actions are accessed using the cog-
wheel popup menu button below the table. Depending on the invoice status, you can 
1. mark the invoice as paid. Economacs will prompt you for the payment date, and the actual 

amount received. If the payment is considered to be partial, make sure the ‘Paid in full’ checkbox 
is off. Unless the invoice is in a foreign currency you cannot accept more money than the invoice 
amount. If you do receive more money, you’ll need to file the extra amount manually. 

2. mark the invoice as a customer loss or as returned. 
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3. revert the invoice to ‘not sent’ status. This is only possible if the corresponding entries haven’t 
been filed. Economacs will attempt to locate the corresponding entries based on the entry name, 
and remove them.  

4. remove the invoice. Although it is not recommended, an invoice can be removed from the list if it 
hasn’t been paid yet. If you use automatic bookkeeping, any corresponding entry is not removed, 
and must be removed manually. 

5. send a reminder. The reminder count will increase (up to a maximum of two) and printing the 
invoice will show a text indicating that it is an invoice reminder. 

You can print the selected invoice by choosing File→Print... from the menu. In the print panel you can 
choose between printing 
1. each selected invoice 
2. the shown list of invoices (in list format) 
3. packing slips (i.e. an invoice without any amounts on it) 
You can also print a C5 envelope (see above) using the envelope button below the invoice list. 

Invoicing settings 
Under the ‘Settings’ group in the sidebar is the ‘Invoicing’ item which gives you access to a number 
of settings related to invoicing. The top left part of this view contains information relating to how your 
customers should go about paying your invoices. This information will be shown in the corresponding 
fields on your invoices. The credit terms can be specified in several different languages. You can 
select between all languages that are defined in the currently selected invoice template group. Specify 
credit terms for all languages in which you plan to send invoices; if you send an invoice in a language 
for which you haven’t defined any credit terms, the credit terms in your default language will be used if 
available. The credit terms are saved for each sent invoice; changing them here won’t affect your 
already sent invoices. 
The top right part shows a list of possible invoice columns. Columns that aren’t checked in the list will 
never be shown on invoices. Other columns will be shown if Economacs determines that they are 
needed. For example, the ’Comments’ column will only be shown if you’ve entered a comment on at 
least one invoice line. This only applies to the built-in invoice templates. 
Custom invoice templates are managed using the ’Manage custom templates…’ button. This opens a 
popover UI where you can add or remove custome templates. To add an invoice template, drag a 
template file (created using the Template Editor) to the list of invoice templates. You can also add 
template files using the ’+’ button below the list. To remove an invoice template, select it and press 
the ’-’ button. For more information regarding invoice templates, please see the documentation for the 
Template Editor. 
This view also contains settings pertaining to automatic bookkeeping. Economacs is built to support a 
workflow where you do your bookkeeping less often than your invoicing. Sending invoices and 
receiving payment for them will generate entries for your journal. These generated entries are put on 
hold in a queue of pending entries, and aren’t filed in the journal until you catch up with your regular 
bookkeeping. You can see the enqueued entries by selecting ‘Pending’ from the sidebar. 
Here you can choose whether to file entries only upon receipt of payment (i.e. not use ‘Accounts 
receivable’) or both upon sending and receipt of payment. For the latter you will need to specify the 
accounts to use. 

Reports 
In the ‘Report’ group of items in the sidebar, you can find the reports listed below. In many of the 
reports you will find date range selection controls at the bottom. Initially the date range will span the 
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entire selected fiscal year. If you limit the date range to, for example, a single month, you can step 
between consecutive months by using the left and right arrow buttons next to the date range. 

Additional reports may be available depending on the region and any loaded plug-ins. 

Settings and preferences 
Under Settings / Company you can access general settings for your company. This includes a profit/
loss account (with account type ‘Cost’). This is the account by which you normally transfer the result 
of a fiscal year into your equity. Knowing this account allows Economacs to exclude this account from 
the ‘Costs’ part of the profit/loss report after the aforementioned transfer has taken place. 

VAT settings 
Under Settings / VAT ’VAT’ in the ‘Settings’ group in the sidebar you can access VAT settings for your 
company. Apart from the VAT number and VAT reporting interval you can also set the different VAT 
accounts to use for different VAT levels. These VAT levels (normal, reduced and further reduced) 
correspond to the settings available for all income and expense accounts in the chart of accounts. 
These settings are used when creating entries with the help of the entry guides. 

Report Description

Overview The default view shown when a document is opened, ‘overview’ provides status 
information for you company. You can see profit or turnover for the selected fiscal 
year as a function of time, an interactive graphical representation of the balance 
sheet, a list of recent invoices, and some key numbers.

Ledger The ledger is a list of all accounts showing all transactions in the currently selected 
fiscal year for each account. Select an account from the list to the right to show the 
transactions for that account.

Balance 
sheet

The balance sheet shows assets and liabilities at the end of the date range. Also 
shown are the values at the start of the selected period.

Profit / loss The profit / loss report shows incomes and costs for the selected date range. If 
you’ve defined tags you can select a specific tag. Only entry rows with the selected 
tag will be included in the profit / loss report.

Suppliers & 
customers

A list of active suppliers and customers. You can limit the selection to those whose 
turnover exceeds the amount specified.

Accounts 
receivable

Using this report you can compare all unpaid customer invoices to the balance on 
the account for ‘accounts receivable’. This report is only available if the accounts 
receivable method for filing invoices is configured under Settings / Invoicing.

VAT-free 
sales

In some jurisdictions within the EU you need to submit this report on all sales made 
without VAT where the customer supplied a valid VAT number. Goods and services 
are reported separately.

VAT Depending on your country settings, a VAT report may be available. This report is 
based on the VAT codes specified in the chart of accounts, and the VAT reporting 
interval under VAT settings.
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Preferences 
Apart from the document-wide settings mentioned above, there are also application-wide settings 
available in the Preferences panel. You can access this panel with the menu item 
Economacs→Preferences…. 
The first tab lets you choose whether to display the startup window when Economacs Launches. In 
the second tab you can choose the application language and how account numbers are displayed 
and sorted.  
The third tab contains various settings for invoicing. Here you can choose how amounts are shown on 
invoices, and whether to hide unnecessary decimals on invoices. 
The last tab lets you manage plug-in modules for Economacs (not available in the Mac App Store 
version due to Apple’s policy restrictions). 

Staying up to date 
If you purchased Economacs from the Mac App Store, visit the App Store application to check for 
updates. If you purchased Economacs directly from us you can select Economacs→Check for 
updates… to see whether updates are available.  

Getting help 
Our online forums at http://www.economacs.com/forum/  are a good place to start with questions 
relating to the use of Economacs. If you have specific problems, please contact our support at 
support@economacs.com. Please note that we are unable to answer bookkeeping questions. For 
that type of questions, please consult a qualified accountant. 

System requirements 
Mac OS X 10.10.1 or later. 
50 MB of hard drive space. 
Internet connection required for some features.
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